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Revision History

Date Description

September 4, 2012 Updated “Shared Storage Support” on page 19 and “Documentation
Changes” on page 28 topic.

IMPORTANT: Avid periodically makes software updates available for download on
Avid.com at the following location:www.avid.com/us/support/downloads. Please
check the above site regularly for information on available downloads for your
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which
contains the latest information that might have become available after the documentation was
published.

This document describes compatibility issues with previous releases, software installation
instructions, hardware and software requirements, and summary information on system and
memory requirements. This document also lists hardware and software limitations.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

A note provides important related information, reminders,
recommendations, and strong suggestions.

& A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

é A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

» This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

(Windows), (Windows This text indicates that the information applies only to the specified
only), (Macintosh), or operating system, either Windows or Macintosh OS X.

(Macintosh only)

Bold font Bold font is primarily used in task instructions to identify user interface

items and keyboard sequences.



If You Need Help

Symbol or Convention Meaning or Action

Italic font Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action  Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the
documentation was published. Also check online for the most up-to-date ReadMe because
the online version is updated whenever new information becomes available. To view the
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues. In addition to the printed documentation supplied
with your editing application, the documentation is supplied in PDF format when you install
the application. Topics that you print from the Help have limited page layout and formatting
features. If you want to print a higher quality version of Help information, Avid recommends
that you print all or part of the PDF version of the appropriate Avid manual included in the
Online Library for your editing application. To access the Online Library, select Help >
Online Library from within your Avid editing application.

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error
messages, to access troubleshooting tips, to download updates, and to read or join online
message-board discussions.

New in Media Composer v6.5, Symphony v6.5, and
NewsCutter v10.5

For information on new features, see the What’s New pdf.


http://www.avid.com/readme
http://www.avid.com/onlinesupport

Before Installing the Editing Application

AMA Plug-ins

Just a reminder that only the AMA QuickTime Plug-in is included with your Avid editing
application. All other AMA Plug-ins are downloaded and installed separately. See
www.avid.com/ama.

Audio Device Drivers

For a listing of currently supported Audio device drivers, see
http://avid.force.com/pkb/articles/en_US/Download/en379411

Before Installing the Editing Application

Read through the Installation Guide for Avid Editing Applications. This document is available on
the Knowledge Base.

(Windows) Note for Administrators: You must give the user the right to “raise thread priority.”
This must be done within the Domain Group Policy by giving the right explicitly to the user or
giving the right to a group and adding the user to that group. You will not be able to launch as a

regular user if this is not set properly.

Download Note: To avoid “File Path too long” or a “File cannot be copied” warning while
unzipping the downloaded installer, try placing the installer .zip on the root level of your C:\
drive and unzip it from that location.

Notes on Macintosh OS

The Avid editing application Macintosh installer switches to 64-bit. Please make sure that your
Macintosh system supports 64-bit prior to installing and that your current non-Avid applications
are compatible to run in 64-bit mode.

Notes on Windows 7 OS

Note the following topics if you are running the editing application on the Windows 7 OS.

Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop
compositing. You can disable it without adversely affecting the Avid editing application.


http://www.avid.com/US/products/Avid-Media-Access

Notes on Software Licensing

You can choose to disable it and continue with your editing session. The dialog will appear once
you relaunch the application unless you disable the option.

To disable the desktop compositing:

1.

AN L B LD

Access the Control Panel.

. Double-click System.

. Click Change Settings.

. Click the Advanced tab.

. Under the Performance area, click Settings.

. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time
you launch the editing application.

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared
Storage environment, mount your workspaces as an Administrator. You may then log off and log
back in as a Standard user, if necessary.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first
deactivate your software. After you upgrade your operating system and, if required, reinstall
your application, you can reactivate your software. For information on activating and
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 4GB of RAM. Some features might require
more RAM and specific hardware. See “Feature Performance” on page 20 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance”
on page 20 for more info.



Qualified Hardware and Operating Systems

The following tables provide the information on qualified Windows and Macintosh hardware.

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the
Open 10 Frequently Asked Questions document on the Knowledge Base:
http://avid.force.com/pkb/articles/en_US/fag/en422991

The following tables also list the qualified Operating Systems. Depending upon your hardware
the qualified Operating Systems are:
*  Windows 7 64-bit SP1(Professional)

e (Media Composer and Symphony) Macintosh Lion v10.7.1 and v10.7.2, v10.7.3, Mountain
Lion v10.8

Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:
1. Click on your system drive (Macintosh HD in most cases) to highlight.
2. From the File menu select Get Info (cmd+I)
3. Click the lock icon in the bottom right to make changes
4

. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

If you repair permissions on the system drive, they will reset and you will have to repeat this
procedure.

Macintosh v10.8 and AVCHD

If you are working with AVCHD and have Macintosh v10.8 (Mountain Lion) OS installed in
your system, the AVCHD folder will appear as a QuickTime icon. You can perform a Link to
Volume the same as you did when working with Macintosh v10.7, just note that the folder
appears as a QuickTime icon. When performing a Link to File, you must right+click the AVCHD


http://avid.force.com/pkb/articles/en_US/faq/en422991

Qualified Hardware and Operating Systems

QuickTime icon and select Show Package Contents. Then you can see the BDV folder. Right
+click the BDV folder and select Show Package Contents. Then you can see the files needed to
perform an AMA Link to File.

Qualified PC Workstations with Avid Media Composer, Avid Symphony,
and Avid NewsCutter

The following PC Workstations are qualified with Avid Media Composer v6 and higher, Avid
Symphony v6 and higher and NewsCutter v10 and higher.

Qualified PC

Hardware Graphics Card Qualified OS Supported with

Lenovo ThinkStation =~ NVIDIA Quadro 600 Windows 7 64-bit
E31, "Intel Xeon graphics adapter or
E3-1245V2 3.40 GHz integrated Intel HD

Software Only

8 GB DDR3-1600 Graphics P4000

RAM

HP z800 Dual 6 Core, NVIDIA Windows 7 64-bit Software Only

2.66 GHz Quadro 4800 Nitris DX

Mojo DX

HP 2800 Dual Quad NVIDIA Windows 7 64-bit Software Only

Core, 2.93 GHz or Quadro 4800 Nitris DX

2.66GHz Mojo DX

HP 2400 Single 6 Core NVIDIA Windows 7 64-bit Software Only

3.33 GHz Quadro FX 3800 Nitris DX
Quadro 2000 Mojo DX

HP z400 Single Quad  NVIDIA Windows 7 64-bit Software Only

Core, 3.06 GHz or 2.93 Quadro FX 3800 Nitris DX

GHz Quadro 2000 Mojo DX

HP 2210 Quad Core Quadro 600 Windows 7 64-bit Software Only

Xeon 3.3- E3-1240, 3.4

E3-1270, 3.5 E3-1280

HP 7200 Intel® Core™ NVIDIA Windows 7 64-bit Software Only

15-660 3.33 4MB/1333  Quadro 600

Dual-Core

Dell™ T5500 Dual 6 NVIDIA Windows 7 64-bit Software Only

Core, 2.66GHz Quadro FX 4800 Nitris DX
Quadro 4000 Mojo DX



Qualified Hardware and Operating Systems

Qualified PC
Hardware Graphics Card Qualified OS Supported with
Dell T5500 Dual, NVIDIA Windows 7 64-bit Software Only
2.93GHz Quad Core Quadro FX 4800 Nitris DX

Quadro 4000 Mojo DX
Dell T3500 Single 6 NVIDIA Windows 7 64-bit Software Only
Core, 3.2GHz Quadro FX 3800 Nitris DX

Quadro 2000 Mojo DX
Dell T3500 Single NVIDIA Windows 7 64-bit Software Only
Quad Core, 2.93GHz  Quadro FX 3800 Nitris DX

Quadro 2000 Mojo DX
HP xw8600 Dual Quad NVIDIA Windows 7 64-bit Software Only
Core, 3.0 GHz Quadro FX 3700 Nitris DX

Mojo DX

Dell T5400 Dual Quad NVIDIA Windows 7 64-bit Software Only
Core, 2.5 GHz or 3.15  Quadro 3700 Nitris DX
GHz Mojo DX
HP xw4600 Core 2 NVIDIA Windows 7 64-bit Software Only
Duo, 3.0 GHz Quadro FX 570 Mojo DX (No HD capture)
Dell T3400 Core 2 Duo, NVIDIA Windows 7 64-bit Software Only
2.33GHz,0r 2.66 GHz  Quadro FX 570 Mojo DX (No HD capture)

Qualified PC Notebooks for Avid Media Composer, Avid Symphony, and
Avid NewsCutter

The following PC Notebooks are qualified with Avid Media Composer v6 and higher, Avid
Symphony v6 and higher and Avid NewsCutter v10 and higher. The following applies to the
editing system when running on a laptop:

*  DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading
enabled. Nitris DX is not supported on laptops.

*  Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.
*  Playback in full quality 10 bit mode is not supported



Qualified Hardware and Operating Systems

Qualified PC
Notebooks Graphics Cards Qualified OS Supported With
Lenovo ThinkPad W530 "NVIDIA Quadro  Windows 7 64-bit Software Only
"Intel Core i17-3720QM 2.6  K1000M or
GHz, i7-2820QM 2.7Ghz, = K2000M
17-3920XM 2.9GHz
HP 8760w 17-282Q, NVIDIA Windows 7 64-bit Software Only
17-2820Q 2.2 or 2.3 GHz Quadro 3000M Mojo DX
Quadro 4000M
HP 8560w, 17-2720Q, NVIDIA Windows 7 64-bit Software Only
2820Q, 2.2 or 2.3 GHz Quadro 1000M
1771920 x1080 Quadro 2000M
Dell M6600, 17-2720Q, NVIDIA Windows 7 64-bit Software Only
2820Q, 2.2 or 2.3 GHz Quadro 3000M Mojo DX
1771920 x1080 Quadro 4000M
Dell 4600, 17-2720Q, 2820Q, NVIDIA Windows 7 64-bit Software Only
2.2 0r2.3 GHz Quadro 1000M Mojo DX
15”1920 x1080 Quadro 2000M
HP 8740w X820, X920 NVIDIA FX Windows 7 64-bit Software Only
Quad i7 (1.73, 2.0 GHz) 2800M Mojo DX
17" 1920x1200 NVIDIA FX
3800M
HP 8540w X720, X820 NVIDIA FX Windows 7 64-bit Software Only
Quad i7 (1.6, 1.73 GHz) 1800M Mojo DX
15" 1920x1080
Dell M6500 i- 820Q, NVIDIA FX Windows 7 64-bit Software Only
17-840Q),17-920X(1.73,1.87, 2800M Mojo DX
2.0 GHz) NVIDIA FX
17" 1920x1200 3800M
HP 8730 2.53 or 3.06 GHz NVIDIA Windows 7 64-bit Software Only
Core 2 Duo Quadro FX 2700M Mojo DX (No HD capture)
Quadro FX 3700M
HP 8530 2.53 or 3.06 GHz NVIDIA Windows 7 64-bit Software Only
Core 2 Duo Quadro FX 770M Mojo DX (No HD capture)



Qualified Hardware and Operating Systems

Qualified PC

Notebooks Graphics Cards Qualified OS Supported With

Dell 6400 2.53 or 3.06 GHz NVIDIA Windows 7 64-bit Software Only

Core 2 Duo Quadro FX 2700M Mojo DX (No HD capture)
Quadro FX 3700M

Qualified Macintosh Workstations for Avid Media Composer and Avid
Symphony

The following Macintosh Workstations are qualified with the Avid Media Composer v6 and Avid
Symphony v6 and higher. Mac Pro systems ship with the 64-bit kernel enabled. In previous
releases, you had to toggle to the 32-bit kernel. With v6 and higher, you must run with the 64-bit

enabled.

Qualified Macintosh

Hardware Graphics Cards Qualified OS Supported With
Mac Pro “Westmere” ATI Radeon HD 5770 Lion v10.7.3 Software Only
Two 2.66GHz 6-Core Nitris DX
Intel Xeon (12 cores) Mojo DX
Mac Pro “Nehalem” NVIDIA GeForce Lion v10.7.3 Software Only
2.66 GHz or 2.93 GHz GT 120 Nitris DX
Dual Quad Core Intel Mojo DX
Xeon

Mac Pro “Nehalem” NVIDIA GeForce GT Lion v10.7.3 Software Only
Dual 2.26 GHz Quad 120

Core Intel

Mac Pro “Harpertown” NVIDIA GeForce Lion v10.7.3 Software Only
Dual Quad Core 3.0 or 8800 GT Nitris DX

3.2 GHz Mojo DX
iMac 27” Display Quad ATI 6970M Lion v10.7.3 Software Only
Core 3.4 GHz

iMac 27” Display Quad ATI 4850 Lion v10.7.3 Software Only
Core 2.93 GHz

iMac 21.5” Display GeForce 9400 Lion v10.7.3 Software Only

Dual Core 3.6GHz

10
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Qualified Macintosh

Hardware

Graphics Cards

Qualified Hardware and Operating Systems

Qualified OS

Supported With

iMac 27” Display
2.8 GHz 4 GB Quad
Core 1066MHz

iMac 27” Display Quad

Core 2.8GHz

iMac 20” Display

2.66 GHz Core 2 Duo

ATI 4850

GeForce 9400

ATI Radeon HD 4850 Lion v10.7.3
Graphics Processor

Lion v10.7.3

Lion v10.7.3

Software Only

Software Only

Software Only

Qualified Macintosh Notebooks for Media Composer and Avid Symphony

The following Macintosh notebooks are qualified with the current editing applications. The
following applies to the editing system when running on a laptop.

*  HD Capture on Macintosh notebooks is not supported

*  Playback in full quality 10 bit mode is not supported

Qualified Macintosh

Notebook Graphics Cards Qualified OS  Supported With
MacBook Air 13” Intel Lion v10.7.3 Software Only
1.7GHz Dual-Core Intel Core i5 3000
or
1.8GHz Dual-Core Intel Core i7
MacBook Pro 17" 6750M Lion v10.7.3 Software Only
2.2/2.3/ GHz Quad Core i7 Intel

3000
MacBook Pro 15" 6490M Lion v10.7.3 Software Only
2.0/2.2/2.3GHz Quad Core i7 6750M

Intel

3000
MacBook Pro 15" GT 330M Lion v10.7.3 Software Only
2.53GHz Dual Core i5 17” only - Mojo DX (no
15” or 17 2.66GHz Dual Core 17 DNxHD capture)
MacBook Pro 15” or 17” 9400M and 9600M  Lion v10.7.3 Software Only

2.53/2.66/2.8 GHz Core 2 Duo

Mojo DX (no DNxHD capture)

11



Qualified Macintosh
Notebook

Compatibility Chart

Graphics Cards Qualified OS  Supported With

MacBook Pro 15” and 17”

2.5 GHz Core 2 Duo

8600M Lion v10.7.3 Software Only

Mojo DX (no DNxHD capture)

Compatibility Chart

The following table lists the operating system, NVIDIA® driver, QuickTime®, Windows Media™,
Avid Interplay®, shared storage, Sony®” XDCAM™, Panasonic® P2, and Pro Tools LE" versions

that were qualified with the Avid editing applications. Also listed are the third-party applications
such as Boris Continuum Complete, Avid DVD by Sonic™, and Sorenson Squeeze®that ship with
the editing applications.

Item

Versions

Comments

QuickTime Support

Windows Media
Version Support

NVIDIA Driver
Support

Shared Storage
Support

Sony XDCAM
driver

Panasonic P2 drive

v7.7.2 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Windows Media Player 12 (for
Windows 7)

v275.89

Avid Unity™ MediaNetwork and
Avid Unity ISIS®.

v2.13 (XDCAM Transfer for
Macintosh)

Win 7-64 FAM 2.3.2 and VFAM
3.1.1

(Macintosh) No device support
for Lion

(Windows 7) Driver version for
P2 devices:v2.16

Note: QuickTime v10X does not include
QuickTime Pro options.

If you do not have Windows Media
Player, access the download at
www.microsoft.com.

Windows Media export compatibility is
subject to Microsoft Windows Media
updates.

See Setting up the NVIDIA Card.

For setting up the driver for stereoscopic,
see the NVIDIA setup info in the
Stereoscopic 3D Workflow Guide.

See “Shared Storage Support” on
page 19.

The VFAM firmware version is 2.45. The
driver can be downloaded from Sony's
website http://esupport.sony.com/.

There is currently no P2 writeback
support for Macintosh clients.

12
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Avid Editing Application Compatibility with Pro Tools

Item Versions Comments
Avid FX v6.0.4 (Windows) Ships with:
v6.0.4 (Macintosh) Avid Media Composer
Avid Symphony

Avid Artist Series  EuControl software v2.5.7 or later See the User’s Guide for information on
(Euphonix) Artist Series Color setup information.

Avid Editing Application Compatibility with
Pro Tools

General Co-Installation Notes:

IMPORTANT: Co-install of the Media Composer and Pro Tools is currently not supported if your
operating system is Macintosh vOSX v10.8 (Mountain Lion).

Install Pro Tools first and then Media Composer.

You must uninstall all older versions of Media Composer or Pro Tools before installing
newer versions.

Co-install does not support both applications launched simultaneously.

When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools
system, this is named the “Safe Uninstall.” On a Windows Pro Tools system, you must select
the first uninstall option — “Pro Tools Only”” — which is not selected by default.

(Macintosh only) When you uninstall your Avid editing application, you must uninstall just
the application and not the audio drivers or Pro Tools no longer sees the devices. When you
start the Avid Uninstaller, deselect the options to uninstall AvidCoreRuntime.pkg and
AvidDIORuntime.pkg.

Mojo SDI will not be supported with Media Composer, but can still be connected in a
co-install configuration for use with Pro Tools.

If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the
editing application does not use any connected Pro Tools audio device for audio input/output
operations. You can also use these audio devices with a software-only version of your Avid
editing application (Media Composer and NewsCutter).

13



Co-installation Configurations and Audio Device Support

* Ifyou run into any issues, uninstall both applications and reinstall Pro Tools first, and then
reinstall your editing application.

*  Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x
and Pro Tools v8.0.1 instead.

» Ifyou want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.

Co-installation Configurations and Audio Device
Support

Avid Pro Tools Applications

MC/NC MC/NC MC/NC/
Pro Tools Software with Mojo Symphony
Product Only DX with Nitris DX
Pro Tools Co-install Co-install Co-install

Software Only

Pro ToolsfHD  Co-install/ Co-install Co-install
Native Audio Device

Pro ToolsfHD  Co-install/ Co-install Co-install
Audio Device

Pro Tools|HD, Not Tested  Not Tested  Not Tested
with chassis

Avid Mbox Family Audio Devices (3rd Generation)

Audio MC/NC MC/NC/
Device Software MC/NC with Symphony
(Interface) Only Mojo DX with Nitris DX
Mbox Co-install/ Co-install Co-install
(USB) Audio Device

Mbox Pro Co-install/ Co-install Co-install

Audio Device
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Co-installation Configurations and Audio Device Support

Audio MC/NC MC/NC/
Device Software MC/NC with Symphony
(Interface) Only Mojo DX with Nitris DX
Mbox Mini  Co-install/ Co-install Co-install
(USB) Audio Device

Avid Mbox 2 Family Audio Devices
Audio MC/NC MC/NC/
Device Software MC/NC with Symphony
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Co-install/ Co-install Co-install
(USB) Audio Device
Mbox 2 Pro Co-install Co-install Co-install
(1394)
Mbox 2 Co-install/ Co-install Co-install
Mini (USB) Audio Device
Mbox 2 Co-install Co-install Not tested
Micro
(USB)

Other Avid Audio Devices
Audio MC/NC MC/NC/
Device Software MC/NC with Symphony
(Interface) Only Mojo DX with Nitris DX
Digi 002 Co-install/ Co-install Co-install
(1394) Audio Device

(Windows)

Digi 003 Co-install Co-install Co-install
(1394)
Eleven Rack Not Supported Not Supported Not Supported
(USB)
Fast Track  Audio Device Not Supported Not Supported
Pro (USB)

15



External Controllers

External Controllers

Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

*  Digi 002 (Windows only — Media Composer and NewsCutter)
+ Command|8

*  Avid Artist Control

*  Avid Artist Mix

*  Avid Artist Transport

*  Avid Artist Color

e JL Cooper MCS-3000X MIDI automation controller

* JL Cooper FaderMaster Pro MIDI automation controller

e Yamaha® 01V/96 and Yamaha 01V digital mixing console

The JL Cooper controllers and Yamaha mixing consoles do not support automation pan
recording.

External controllers or mixers are optional. They are not required for you to perform automation
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Digi 002 Avid Artist Avid Artist Avid Artist Avid Artist
Feature (MC/NC only) Command|8 Control Mix Transport Color
Control surface Yes Yes Yes Yes Yes
for transport (transport
controls and only, no soft
other functions keys)
Provides audio  Yes No No No No
play, input, and
output
Record Yes Yes Yes Yes No
automation gain
Record Yes Yes Yes Yes No
automation pan
Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No
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External Controllers

Digi 002 Avid Artist Avid Artist Avid Artist Avid Artist
Feature (MC/NC only) Command|8 Control Mix Transport Color
Touch-sensitive Yes Yes Yes Yes No
faders
Touch-sensitive No No Yes Yes No
panners
Solo/mute Yes Yes Yes Yes No
Supports audio No?* No No No No
mixing
Latch mode Yes Yes Yes Yes No
(also known as
Snap mode)
Number of 1024 1024 1024 1024 Not applicable
steps of fader
accuracy

a. The Dig1 002 can be used as a standalone audio mixer but not at the same time as 1t 1s being used as an automation gain or
automation pan controller or control surface.

The following table compares supported third-party external controllers and mixers.

Feature

FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V

Control surface for transport
controls and other functions

Provides audio play, input, and

output

Record automation gain

Record automation pan

Flying faders

Touch-sensitive faders

Solo/mute

Supports audio mixing

Latch mode (also known as

Snap mode)

No

No

Yes

No

Yes
Yes

Yes

Yes

No

17



Setting up the NVIDIA Card

Feature FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V
Number of fader steps of 128 1024 256
accuracy

a. For Yamaha tader/controllers, solo works only 1f you do not use the unit for audio mixing at the same time

For more information on using these external fader controllers or mixers, see “Recording
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version
(install the display driver if necessary, and set the correct display settings. This version of the
editing application requires the following Nvidia Driver:v275.89

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder
that installs with your Avid application.

Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.
To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click the folder that
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:
1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.
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To
1

set Desktop Video Editing Mode:
. Right-click the Desktop, and select Nvidia Control Panel.

Shared Storage Support

2. In the menu bar, select Desktop. Enable Desktop>Video Editing Mode.

3

To set the Prefer Maximum Performance mode and Global Settings:
1.
2
3.
4. In the Global Settings tab, change Power Management mode to Prefer Maximum

5.

6.
7.

. Click Apply.

Right-click the Desktop, and select Nvidia Control Panel.
. Click Manage 3D Settings.
Set Global presets to Base profile.

Performance.
Click Apply.
Set the Global preset to 3D App-Video Editing.
Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so.
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following.

There is no support for ethernet attached clients in a MediaNetwork environment.

Editing

Application ISIS ISIS Media- Media-

Operating 5000 5000 ISIS 7000 ISIS 7000 Network Network

System Client Server Client Server Client Server

Windows 7 64-bit  v3.5, v3.2, v3.5,v4.0 v2.4.v4.0 v5.4 v5.1.3
v4.0 v4.0

Macintosh Lion  v3.5, v3.2, v3.5,v4.0 v2.4.,v4.0 v5.5.1 v5.1.3

v10.7.3 v.4.0 v4.0
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Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might
experience problems if you are working on an older system. The following chart shows the
hardware that Avid has successfully qualified when using these features.

Feature Description Recommended System

J2K Capture .

Stereoscopic 3D For optimal performance with .
Stereoscopic 3D, use these higher
performance systems. Avid
recommends a minimum of 12GB
RAM when using Stereoscopic
3D. .

XDCAM HDS50 Capture  Baseband capture through Nitris ¢
DX, Mojo DX

HP z800 Dual Quad Core, or Dual 6
Core, with Hyperthreading On

Dell T5500 Dual 6 Core with
Hyperthreading On

Mac Pro Dual 6 Core “Westmere”
HP z800 Dual Quad Core, or Dual 6
Core, with Hyperthreading On

HP z400, 6-core with Hyperthreading
On

Dell T3500 Single 6 Core with
Hyperthreading On

Dell T5500 Dual, 2.93GHz Quad
Core with Hyperthreading On

Mac Pro Dual 6 Core “Westmere”
HP z800 Dual Quad Core, or Dual 6
Core, with Hyperthreading On

HP z400, 6-core with Hyperthreading
On

Dell T3500 Single 6 Core with
Hyperthreading On

Dell T5500 Dual, 2.93GHz Quad
Core with Hyperthreading On

Mac Pro Dual Quad Core “Nahalem”
or Dual 6 Core “Westmere”
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Feature Description Recommended System
HD RGB HD RGB capture requires a high + HP z800 Dual Quad Core, or Dual 6
end workstation with Nitris DX Core, with Hyperthreading On
and fast storage. (The HP z800 . .
HP z400, 6- th Hyperthread
and the Dell T5500 have been Oy reore MR TpErERding
qualified to successfully play
back 2 streams with PIP and *  Dell T3500 Slngle 6 Core with
Color Correction effects. The Mac Hyperthreading On
Pro Dual Quad Core “"Nahalem™ . pe|| T5500 Dual, 2.93GHz Quad
sqccessfully plays back 2 streams Core with Hyperthreading On
with PIP)
*  Mac Pro Dual Quad Core “Nahalem”
or Dual 6 Core “Westmere”
» Storage: 10Gb Ethernet ISIS,
AMA (RED) AMA is a processor intensive » HP 2800 Dual Quad Core, or Dual 6
operation. Older platforms may Core, with Hyperthreading On
not offer optimum performance. HP z400, 6-core with Hyperthreading
On
* Dell T3500 Single 6 Core with
Hyperthreading On
e Dell T5500 Dual, 2.93GHz Quad
Core with Hyperthreading On
*  Mac Pro Dual Quad Core “Nahalem”
or Dual 6 Core “Westmere”
AMA (QuickTime) AMA is a processor intensive Recommendation of qualified systems
operation. Lower end platforms  depends on your planned use of this
may not offer optimum feature. Heavy usage of highly
performance. Highly compressed compressed codecs requires the high end
codecs such as H.264 will exhibit systems.
minimal real-time performance.
Ancillary Data Ancillary Data and Nitris DX: Dual Quad Core or dual 6-core Systems
Due to software DNxHD codec
performance requirements, you
must have a dual quad core
system in order to capture
DNxHD 220 or 220x with
ancillary data on the Nitris DX
platform.
DVCPro HD capture You will get better performance  Dual Quad Core or dual 6-core Systems

with a dual quad core or dual
6-core system.
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Feature Description Recommended System
AVCl-Intra AVC-Intra(AVC-I) is a high 4-Way MultiCam Playback
guallty,é(;%blt;ratg HD codecand HP z800 Dual Quad Core or Dual 6
18 very fntensive. Core, with Hyperthreading On -

64-bit OS

*  Mac Pro Dual Quad Core “Nahalem”
or Dual 6 Core “Westmere”

Four Stream Playback:

* HP 2800 Dual 6 Core with
Hyperthreading On - 64-bit OS

*  Mac Pro Dual 6 Core “Westmere”

Two Stream Playback:

» HP 2400, single 6 Core with
Hyperthreading On

Single Stream Playback:

* Systems listed above.

» HP 2400, single 4-core with
Hyperthreading On

* HP 8600, dual 4-core without
Hyperthreading On

* HP 8740w laptop, i7 (1.73GHz)
4-core with Hyperthreading On

» HP 8540w laptop, i7 (1.73GHz)
4-core with Hyperthreading On

* Dell Precision M6500 laptop, i7 (2.00
GHz) 4-core with Hyperthreading On

* The MacBook Pro 17" laptop, 17 (2.66
GHz) 2-core with Hyperthreading On

* iMac 27", 17 (2.8GHz) 4-core with
Hyperthreading On

Limitations

The following limitations apply to the current version of the editing application.
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Avid Artist Color

>

Some soft keys do not light up when you use the Avid Artist Color with your Avid editing
application, including the following:

*  HSL Shift Layer: all soft keys

« HSL Bank 2 Shift Layer: all soft keys

*  Curves: F8 and F9 soft keys

*  Curves Shift: F1, F3, F6, and F9 soft keys
* Secondary: F2, F7, F8, and F9 soft keys

e Secondary Shift: all soft keys

The soft keys listed above function normally even when they do not light up.

When you use the Artist Color controller to perform color corrections, the Avid editing
application might show some degradation of performance when safe color warnings are
displayed. If you turn on safe color warnings and then perform a color correction, you might
notice that the movement of the cursor becomes uneven.

Workaround: If you experience slower or uneven performance, turn safe color warnings off
before you perform your color corrections.

Hue offset color wheels might not appear when you use Artist Color to enter Color Correction
mode the first time after start your Avid editing application. Any parameter update will draw
them.

Workaround: When you make any change in a parameter in the Color Correction tool, the
color wheels appear.

Currently only the Master controls for the Hue Offset and the Controls tabs of the HSL Group in
the Color Correction tool are mapped to controls on the Artist Color controller. Hue Offset and
Control parameter controls for Shadow, Midtones, and Highlights, as well as the Luma curves
are not mapped. You must use the Color Correction tool to adjust these controls.

(The F2 soft key (Next HSL Subtab) does not function until after you apply a color correction to
your footage. If you press F2 (Next HSL Subtab) on the Artist Color surface before you apply a
color correction, you get a system beep and the subtab does not change.

If you use the HSL shift control for trackballs, you might see the trackballs controlling the wrong
monitor during shuttle. For example, if you press Shift and then use the right trackball to shuttle,
and then move either the left or the center trackball, you might see the other trackballs now
control the right monitor.
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You might notice slower or uneven performance when making color corrections with safe color
warnings turned on.

Workaround: Click one of the Actions buttons in the Safe Color Settings dialog box, and select
Ignore to turn safe color warning off.

When you first ope n the Color Correction tool, either with the Artist Color or with the mouse,
incorrect color correction values might display in parameter fields. This problem is intermittent,
and it does not occur after you change a parameter value.

Workaround: Adjust any parameter. The correct values display in the Color Correction tool.

(Macintosh only): The EuControl application does not open when you select Edit Settings in the
Controller Settings dialog box. To configure your EUCON device, you must open the EuControl
application by clicking the EUCON icon in the dock, and then selecting Window > EuControl
Settings.

Compatibility

>

Effects

>

You might receive AMPI Subsystem errors when launching the editing application. Avid
recommends that you refer to the following Knowledge Base article for information on possible
causes.

http://avid.custkb.com/avid/app/selfservice/search.jsp?Docld=377091

You must have the MediaNetwork client installed on your system in order to play linked AMA
clips from the MediaNetwork shared storage.

The Standalone Transfer Manager will be supported with this release, except for compatibility
with Airspeed Classic and Open I/O devices.

AVX 1 effects are no longer supported and will not be recognized in this latest version of Media
Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2 64-bit version of
any existing plug-in that you might have purchased. The following Avid AVX1 effects will
automatically be promoted to AVX2:

e Avid Pan & Zoom
*  Region Stabilize
* RGB Keyer
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When you load a previously-generated sequence containing one of these effects, they will
automatically be promoted to new corresponding AVX2 effects. These effects will not be
recognized by earlier versions of Media Composer.

Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and
selecting one of the pan value options. However, if you want to manipulate pan control points
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel
for any audio track and select a pan value option.

Interplay

>

The Active Format Description (AFD) bin column value does not consistently check-in to
Interplay when a sequence is checked-in.

Interplay v.2.5 support for native HD 23.976p and HD 24p formats now includes their associated
proxy resolutions. For more information refer to the Avid Interplay Best Practices Guide.

(Interplay) Dynamic relink is not currently supported for media that requires pulldown.
Therefore, you can only use it with clips where the media has been acquired at the native frame
rate (without pulldown).

(Interplay) Pro Res formats can only be used by Avid editing applications that are in a
non-Interplay environment. For any additional limitations regarding running an Avid editing
application in an Interplay environment, see the Interplay ReadMe.

(Avid Interplay and Windows 7) Can't locate Media Indexer on Avid editor after first install.
After an initial installation of the editor and Interplay support software, the editing application
may fail to locate the Media Indexer. This can happen if some of the Avid Service Framework
services have not started correctly.

Workaround: Open the Workgroup Properties tool on the editor and check whether any of the
services are not running. Restart any services as required. Then restart the Avid editing
application again. You may have to do this the first few times that you start the editor. After a few
times the services will begin starting automatically, even after a reboot.

Mixed Frame Rates

>

After modifying a sequence across frame rates, you might see variations in clip durations that
result in out of sync issues across tracks (for example, sync off by 1 or 2 frames). This is due to
calculations required for crossing frame rates that might result in roundoff errors. Therefore if
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you experience these sync issues after modifying a sequence across frame rates, you might need
to go into trim mode and make adjustments. Also keep in mind that round-tripping the sequence
back to its original rate will not necessarily restore it to its original exact contents.

Media Tool

»  If the Media Tool window is set to Frame view, you might experience slow redraw issues when
accessing large volumes of shared storage.

Output

»  You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for
1080p projects or when you are in Stereoscopic mode.

Workaround: When in stereoscopic mode or have True Progressive output set for 1080p
projects, the down-convert and cross-convert options are not available. To output at a rate
different than the project format, go to the Format tab and change the output project setting.

PhraseFind

»  For best results with PhraseFind, Avid recommends using Avid certified storage solution.
Play

»  After editing for an extended period of time, using the keyboard arrow keys to single step
through the sequence might skip frames or move in the wrong direction.

Workaround: Minimize and maximize the editing application or change focus to another
application and then back to the editor.

»  You might receive an “Exception: The sequence or one of its source elements is too long to be
played” error if you have a sequence over 12 hours.

QuickTime

»  QuickTime Reference movies are not supported by QuickTime Player X. They are still supported
in QuickTime Player 7 on the Macintosh. They are also not supported in QuickTime version
7.6.9 on Windows.
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Stereoscopic 3D

>

>

A software developer's kit is now available for 3rd-party partners who would like to build AMA
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences
compatible with Avid Media Composer or Symphony. This developer's kit is available on the
Avid website.

720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party
vendors.

If a rolling title is used in an Over\Under stereo project, you may get the wrong scaling and
cropping of lines.

Stereoscopic projects are not supported on Avid Interplay.
Multicam of stereoscopic clips is not supported.

NVIDIA 3D Vision

*  Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully
tested.

*  Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows
system.

*  Due to an NVIDIA driver issue, the first time that the full screen play window appears, the
application will resize to a single monitor. Resize the application as necessary. You can reset
your window positions by clicking on a toolset in the menu.

Ancillary data output is not supported if you are working in full stereoscopic format.

Timeline

>

If you have a sequence loaded in the Timeline, and you have waveforms on, clicking or dragging
in the Timeline does not stop the waveform from drawing.

Workaround: Hold Cmd + . to stop the waveform from drawing.

User Interface

>

You cannot copy and paste timecode values into the Source or Record monitors. To enter
timecode in the monitors, select the monitor and then type in the appropriate timecode values.
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»  You can drag audio keyframes past adjacent audio keyframes. Moving an audio keyframe past
another keyframe causes the keyframes to swap values. For example, set volume levels on two
audio keyframes: Keyframe A for low volume (left keyframe) and Keyframe B for high volume
(right keyframe). If you then drag Keyframe A to the right of Keyframe B, Keyframe A now
displays the higher volume level.

»  (Macintosh only) If you load a group clip into the Source monitor while in MultiCamera mode,
the monitor displays the clip as if MultiCamera mode is still selected, although the action of
loading the group clip actually causes the Avid editing application to enter Source/Record mode.
If you play back the clip, you only see the linecut and cannot perform MultiCamera edits.

Workaround: To turn off the Multicamera mode display, select Special > Multicamera Mode,
and make sure MultiCamera Mode is not selected.

»  (Macintosh only) If you render a sequence containing a title by selecting Clip > Render In/Out or
by right-clicking the sequence and selecting Render In/Out, the progress bar displaying the status
of the render operation does not update and the application appears to become unresponsive.
However, even though the progress bar does not advance, the rendering operation continues.
When it completes, the progress bar closes.

Documentation Changes

The following documentation changes were made after the initial documentation release was
finalized. These will be corrected in the next release of the product.

Committing Assets to an Export Volume
In the What’s New for v6.5, the topic “Committing Assets to To an Export Volume” should have

stated that once you commit the assets, the sequence is flattened to the OP1b format, the video is
encoded to the codec set in the selected shim and audio saved as PCM.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.
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Trademarks

003, 192 Digital I/0, 192XD 1/0, 888 1/0, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, Alienbrain, AniMatte, AudioMarket,
AudioPages, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive,
Avid DS Assist Station, Avid EditStar, Avid Learning Excellerator, Avid Liquid, Avid Liquid Chrome Xe, Avid MEDIArray, Avid Mojo,
AvidNet, AvidNetwork, Avid NewStar, Avid Remote Response, AVIDstripe, Avid Unity, Avid Unity ISIS, Avid VideoRAID,

Avid Xpress, AVoption, AVX, Beauty Without The Bandwidth, Boom, C|24, CaptureManager, ChromaCurve, ChromaWheel,
Command|24, Conectiv, CountDown, DAE, Dazzle, Dazzle Digital Video Creator, Deko, DekoCast, D-Fi, D-fx, DigiDelivery,
Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, DigiLink, DigiMeter, DigiSerial, DigiStudio,
DigiStudio Control, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, DVD Complete, D-Verb, Eleven,
Equinox, EveryPhase, ExpertRender, Fastbreak, Fast Track, FieldPak, Film Composer, FilmScribe, Flexevent, FluidMotion, FXDeko,
G7, G-Rack, HD Core, HD Process, HDPack, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, lllusionFX,

Image Independence, INEWS, INEWS Assign, INEWS ControlAir, Instantwrite, Instinct, Intelli-sat Broadcasting Recording Manager,
Intelli-Sat, InterFX, Interplay, inTONE, Intraframe, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus,
Lightning, ListSync, Lo-Fi, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, M-Audio, M-Audio Micro,
Maxim, Mbox, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media lllusion,
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MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Media Suite, Meridien, MetaFuze, MetaSync,
MicroTrack, Midiman, MissionControl, Mix Rack, MixLab, Moviebox, Moviestar, NaturalMatch, Nearchive, NetReview, NewsCultter,
Nitris, NRV-10 interF X, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, Open Media Management,
Palladium, Pinnacle, Pinnacle DistanTV, Pinnacle Geniebox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media,
Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, ProEncode, ProServices, ProSessions, Pro Tools, QuietDrive,
Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, RetroLoop, rS9, rS18, Salesview, Sci-Fi, Scorch, Scorefitter,
ScriptSync, SecureProductionEnvironment, Session, Show Center, Sibelius, SIDON, Soft SampleCell, Soft-Clip Limiter,

Sound Designer Il, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Sputnik, Starplay, SteadyGlide, Streamfactory, Streamgenie,
StreamRAID, Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, Symphony, SYNC HD, SynchroScience,
SynchroScope, Syntax, TDM FlexCable, Thunder, Titan, Titansync, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase,

TL Fauxider, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Torq, Torq Xponent, Transfuser, Trigger Finger, Trillium
Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Venom, VideoRAID, Video Slave Driver, VideoSPACE, VideoSpin, Vortx, Xdeck,
X-Form, Xmon, Xponent, and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United
States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other
trademarks contained herein are the property of their respective owners.
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